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Synopsis

Statistics on eye health in Australia in September 2003 have estimated that there are currently approximately 380,000 people living in Australia with legal blindness or low vision (Vision Australia Foundation, 2003). This number is expected to double in the next 20 years, as a result of the ageing population. As a result, considerable research work has been contributed significantly to an understanding of the needs of visually disabled people for participating fully in fundamental activities of life. One of the many issues faced by people suffering from a large degree of vision impairment is the determination of Australian currency notes. There needs to be significant research in this field which specifically addresses features that will make it possible for all visually disabled individuals to denominate Australian banknotes independently and confidentially. 

In this project, the design and construction of a prototype currency identification device was implemented. It consists of a charge-coupled device (CCD) linear array which scans the bottom clear window of the note, and processing is digitally done via the Texas Instruments TMS320VC5510 digital signal processing (DSP) chip. This thesis will explore the software aspects of this project and programming with the DSP board in general. Details about the recognition algorithm can be obtained from the thesis by Siang Jin Ting, and of the hardware aspects, Sin Ying Lim. 
Yati Hong

3 Bunning Place

Kardinya

Western Australia 6163

27 October 2004

Professor Syed Islam

Head of School
School of Electrical and Computer Engineering

Curtin University of Technology

Kent St, Bentley 

Western Australia 6102

Dear Professor Islam,

I take pleasure in submitting the following thesis entitled “Currency Identification for the Blind” to partially satisfy the requirements for the Bachelor of Engineering (Computer Systems) degree. This thesis is entirely my own work outside of where acknowledgement is given. 
Yours Sincerely,
Yati Hong
[image: image32.png](TOP VIEW)




Acknowledgements

The author would like to take this opportunity to convey her most sincere gratitude to, first of all, her project supervisor, Mr. Iain Murray, for his insightful guidance, assistance and genuine interest in this project. Many thanks go to her project partners, Jason and Sin Ying, for their tremendous effort and dedication throughout the course of this project. Special gratitude is also extended to Mr. Andrew Pasquale for rendering generously his time and expertise with the Texas Instruments DSP development kit, and Mr. Ryan Binns, whose tireless work provided a strong foundation for the success of this project. Finally, the author would like to express her deepest gratitude to her boyfriend Gordon and her best friend Alicia, for editing and proofreading her thesis, but more importantly, for their encouragement, patience, love and support throughout her years of study.  
[image: image33.png]Freqt=2 000z PerTodc>=501.0ns



Index

11.0
Introduction


11.1.
Motivation for a Currency Identification System


21.2.
Overview of Currency Identification System


41.3.
Project Scope


61.4.
Thesis Layout and Outline


82.0
Design considerations of currency identification


82.1.
Current Available Currency Identification Methods


92.2.
DSPs vs Microcontrollers


112.3.
Choice of DSP chip


133.0
Integrated Development Environment


133.1.
Code Composer Studio Overview


133.2.
Project Creation


133.3.
Configuration Files


143.4.
Loading program into DSK


154.0
Scanning sub-system


154.1.
The TSL208 Linear Sensor Array


164.2.
Scanning Constraints


185.0
Timers/Clocks sub-system


185.1.
Generating a CCD Clock


195.1.1.
Approach 1 - System Register (SYSR)


205.1.2.
Approach 2 – General Purpose Timer


245.2.
Generating a Serial Input (SI) Line


245.2.1.
Approach 1 – General Purpose I/O


255.2.2.
Approach 2 – General Purpose Timer


276.0
Data Acquisition sub-system


296.1.
McBSP receive operation


306.2.
McBSP clocking


316.3.
McBSP Frame Synchronisation


326.4.
McBSP Receiver Configuration


336.4.1.
Global McBSP behaviour


346.4.2.
Data behaviour


366.4.3.
Frame Synchronisation behaviour


376.4.4.
Clocking behaviour


397.0
System Integration and Testing


397.1.
System Integration


437.2.
System Testing


458.0
Implementation results


458.1.
2MHz Clock Generation Output


458.2.
Synchronisation Signal (Serial Input line) Output


478.3.
Scanning Output


509.0
Conclusion


509.1.
Objectives Achieved


519.2.
Recommendations for Future Work


519.2.1.
McBSP power management


529.2.2.
Improved CCD scanner


529.2.3.
Memory Management


5410.0
References


56Appendix A -  Project Plan


57Appendix B – Bit layouts of timer registers


58Appendix C – Bit layouts of McBSP registers


60Appendix D – Program Source Code


69Appendix E – Image of Project Setup




List of Figures

12Figure 1: Functional Block Diagram of TMS320VC5510


16Figure 2: CCD Array and Operational Timing Waveforms


18Figure 3: Conceptual Block Diagram of the General Purpose Timer


19Figure 4: System Register (SYSR) Bit Layout


28Figure 5: Block Diagram of the McBSP


31Figure 6: Timing diagram example of  8-bit serial word data


39Figure 7: Integrated System Block Diagram


44Figure 8: DSP Software Flowchart


45Figure 9: CRO output of 2MHz clock


46Figure 10: CRO output of Serial Input and Serial Output signals


46Figure 11: CRO Output of scanner in ready mode


47Figure 12: CRO Output of scanner scanning non-opaque material


48Figure 13: CRO output of scanner scanning opaque material


49Figure 14: CRO output of scanner scanning a 50 dollar note


49Figure 15: Scanner over 50 dollar note




List of Tables
17Table 1: TMS320VC5510 DSP timing requirements


20Table 2: Valid System Register CLKDIV values


20Table 3: DSP General Purpose Timer Registers


21Table 4: FUNC bit configuration for the general purpose timer


29Table 5: McBSP receive interface pins


37Table 6: Effect on FSR pin with different combinations of register bits


38Table 7: Effect on CLKR pin with different combinations of register bits




1.0 Introduction
1.1. Motivation for a Currency Identification System

Statistics on eye health in Australia in September 2003 have estimated that there are currently approximately 380,000 people living in Australia with legal blindness or low vision (Vision Australia Foundation, 2003). This number is expected to double in the next 20 years, as a result of the ageing population. As a result, considerable research work has been contributed significantly to an understanding of the needs of visually disabled people for participating fully in fundamental activities of life. One of the many issues faced by people suffering from a large degree of vision impairment is the determination of Australian currency notes. There needs to be significant research in this field which specifically addresses features that will make it possible for all visually disabled individuals to denominate Australian banknotes independently and confidentially.
A desirable approach of currency note design would be to permit virtually all visually disabled individuals, together with normally sighted persons, to denominate banknotes without the aid of devices. It is conceivable, however, that under certain circumstances, very simple, inexpensive, unobtrusive and accurate devices could be of assistance under dim lighting conditions – not only to visually disabled people but also to normal sighted individuals. There currently exists no such device described above that is capable of accurately differentiating Australian polymer notes. Therefore, there exists a need for a handheld device which is:

· Small

· Cost effective

· Accurate

· Easy to operate, and

· Power Efficient.

The system described below is a prototype device that was designed and constructed in attempt to provide vision impaired members of the community with a small device that would assist in note differentiation. 
1.2. Overview of Currency Identification System
In this project, the design and construction of a prototype currency identification device was implemented using the Texas Instruments TMS320VC5510 digital signal processing (DSP) development kit. The entire system can be broken down into several sub-systems, each of which can be designed and/or implemented separately and brought together to form the complete system. These sub-systems are outlined below and will be discussed in further detail in the following sections of this thesis (unless specified otherwise).
· Scanning Sub-system
Consists of a charge-coupled device (CCD) linear array which the user runs the dollar note over.
· Timer / Clock Sub-system
The internal clock was divided down and routed to timer output pins, and was used by the scanning sub-system and data acquisition sub-system for synchronisation purposes. 

· Data Acquisition Sub-system
Data was acquired utilising one of the Multi-Channel Buffered Serial Ports (McBSPs) on board the TMS320VC5510 DSP Starter Kit (DSK). 

· Image Recognition Sub-system
Once data was acquired, the image recognition algorithm could be applied to identify the note.

· Additional External Hardware Circuit Sub-system

A couple of external hardware circuits had to be constructed to assist in the operation of the currency identification system. These included the flashing circuit for the scanning of the note, as well as a voltage comparator circuit which essentially behaves as an A/D converter for the currency scans. 
1.3. Project Scope

Three students were involved in the design and implementation of this particular project.  Although it was difficult to stringently divide the project into exactly three parts with equivalent workload, it was decided that each student would handle each of the three main parts of the project, but at the same time working cohesively as a team and rendering help whenever required. The three main parts mentioned above were defined as follows:
1. Image recognition algorithm design and implementation – this involved researching into various image recognition algorithms and developing a method which best suited the project’s aims. This required the student to ensure that the algorithm was both simple yet efficient. The correctness of the algorithm design was initially tested in MATLAB and later ported to C on the TMS320VC5510 DSP starter kit.    

2. Software development and programming of DSP chip – The implementation of the project was largely done using the DSP starter kit (DSK), which was used for coding, testing and debugging. This is crucial if a final product was to be made, because the DSK consists of the actual DSP chip that would be embedded within the product, as well as numerous controllers and functions wrapped around the chip that assist in development of the software that would eventually run on the chip itself. 
3. Additional hardware design and circuit fabrication – In the development of any embedded device, there exists the software design as well as the hardware considerations. Here, choices had to be considered and decisions had to be made about which type of hardware would be more suitable for the project. External circuits had to be fabricated to provide additional functionality not provided by the DSK.

As can be seen, there is a great deal of cohesion in this project in a group environment. The student involved in designing the recognition algorithm had to work closely with the student involved in software development so that the algorithm could be correctly ported into the C language on the required platform, as well as working with the student in charge of making hardware decisions, to ensure that the hardware is capable of performing the required tasks. On the other hand, the student involved in software development had to also work closely with the student working with hardware so that limitations of the hardware can be made known to the student developing the software, and any additional functionality not provided by the DSK can be relayed to the hardware designer so that external hardware circuits could be fabricated. 

The scope of this thesis will only cover the software development and programming of the DSP chip. Details of the image recognition algorithm can be obtained from the thesis by Siang Jin Ting, and that of the hardware circuits, from the thesis by Sin Ying Lim. 
1.4. Thesis Layout and Outline

Chapter 2: Design Considerations of Currency Identification – This chapter first introduces and evaluates the existing available currency identification methods and addresses the improvements which would need to be considered. Design decisions regarding the choice of processing chip used to implement the project are presented next, giving a comparison between a few available options. 

Chapter 3: Integrated Development Environment – discusses the integrated development environment (IDE), Code Composer Studio, used to implement the program, as well as the way this application was set up to suit the needs of the project.  
Chapter 4: Scanning sub-system – discusses the linear sensor array used in this project and the scanner timing constraints placed upon the project in a software point of view.
Chapter 5: Timers/Clocks sub-system – discusses the way in which the timers provided by the DSK were used to generate a clock and a synchronisation signal for data scanning and acquisition. Several methods are proposed and evaluated for their effectiveness and suitability, and the final choice and implementation details are provided.

Chapter 6: Data Acquisition sub-system – discusses the way in which the scanned data is fed back via the multi-channel buffered serial ports (McBSPs) into the DSP chip for processing. This chapter illustrates in detail the way in which the McBSP registers are configured to suit the needs of the project.  

Chapter 7: System Integration and Testing – discusses how the components of the project are brought together and integrated into a full working system. The way in which the software program was testing is also explored. 

Chapter 8: Implementation Results – illustrates the results of the implementation and discusses the validity of them.
Chapter 9: Conclusion – summarises the project as a whole, discussing the issues addressed, objectives achieved, and the resulting outcomes. Recommendations for future work discusses how the project from a software point of view for this project can be improved upon, to make its operations more accurate. 
2.0 Design considerations of currency identification
2.1. Current Available Currency Identification Methods
Since the introduction of thin, flexible polymer notes in 1990, which slowly replaced the old paper notes, the notes have been harder to differentiate for the blind. Although the polymer notes can be brightly contrasted by their vibrant colours, they are difficult for a person with vision impairment to differentiate, as their sizes are identical in width and only slightly vary in length, as opposed to the old paper notes which differ in width as well. 

In some countries, blind people carry templates to denominate banknotes in accordance with size differences. It has been observed that after a short time, people who are blind learn to recognize denominations utilizing their sense of touch and no longer use the template. On the other hand, if templates were built into wallets or other types of billfolds, it is probable that they would be used more extensively. 

Although it is conceivable that under certain circumstances, very simple, inexpensive, unobtrusive and accurate devices could be of assistance under dim lighting conditions – not only to visually disabled people but also to normal sighted individuals, there currently exists no such device that is capable of accurately differentiating Australian polymer notes. Research has been done however, in the adaptation of current devices. Fixed-placement devices are currently in use in vending machines, ATMs, and retail establishments (e.g. ultraviolet lamps to detect the presence of optical brighteners). Device designers could make devices more portable, smaller, faster and more reliable, both for use by visually disabled individuals and for those who currently use fixed-placement devices.

Some types of very simple, inexpensive, devices that are currently available that could prove useful for banknote denomination in various settings are a small flashlight on a keychain, which could be made wavelength-selective utilizing filters; a small magnifying glass, perhaps equipped with a light source; plastic templates that could be used to denominate different-sized banknotes, a light source as either light-emitting diodes (LEDs) or lasers to emit a single wavelength or a broad spectrum of light; and finally, a simple magnetometer that senses a predetermined magnetic pattern in the banknote that converts the information to aural, visual or tactile information. 
2.2. DSPs vs Microcontrollers

The first design issue faced was deciding between a DSP chip and a microcontroller. Although previous implementations had facilitated the use of DSP chips, the option of using microcontrollers instead was investigated.

Many of today’s embedded applications require processing real-time signals. Examples include digital TVs, digital cameras, cellular phones and modems. Processing signals in real time requires extensive number-crunching capabilities. Digital signal processors, or DSPs, have integrated hardware multipliers that let them perform sophisticated math quickly. The devices offer high performance, low cost, and low power for real-time applications. And, because they are programmable, DSPs assure fast time to market and ease of design, maintenance and feature upgrades. However, DSPs have the reputation of being difficult to program. 
With the current levels of integration, microprocessors, microcontrollers and DSPs can all function as standalone devices and have similar peripherals. However, DSPs have the ability to process signals continuously in real time. Unless the application is quite simple, microcontrollers and microprocessors cannot keep up to real time processing. They are best for control applications that involve taking a snapshot and making a decision based on that information. In contrast, DSPs continuously monitor what is going on and modify the output based on that data, e.g. real-time signals such as voice, audio, images and video. Before DSPs became sophisticated, they offloaded the math-intensive processing from the microcontroller and let the controller make decisions based on the results. Now, they are sophisticated enough to make decisions themselves and take on some of the control applications. According to Texas Instrument’s Business Development Manager, Gene Frantz, “If 80 percent of the system-level task is best suited for a microcontroller, the designer should seriously consider using the microcontroller to do the DSP tasks – if it can. If 80 percent of the system-level task is real-time DSP activity, the remainder of the tasks should be handled by the DSP” (McNamara, 2001). 
Since the majority of the tasks performed within this currency identification system require real-time activity, it was decided that a DSP chip should be used, as it is more suited to dealing with images. 
2.3. Choice of DSP chip

As it was decided that a DSP chip would be used in the implementation of the system, the problem then was to decide which DSP chip was to be used. Past implementations of the system have had problems with the lack of on board memory.  It was based on a TMS320VC5402 DSP processor which runs at 100MHz and includes 16kW of on-chip RAM and 4kW of on-chip ROM. However, because of problems encountered, the only memory available to hold program code and data is the DSP’s on-chip RAM, which, as mentioned above, is only 16kW in size. This proved to be a concern, so it was decided that a TMS320VC5502 DSP processor, which runs at 200MHz and includes 32kW of on-chip RAM and 16kW of on-chip ROM, could be used. However, it was later found that although the 5502 chip would work well and would reduce power consumption in the implementation, cost restrictions had rendered this impossible.  
The final decision was that the TMS320VC5510 DSP chip would be used. The 5510 DSP chip runs at 200MHz, with 8Mb on-chip synchronous DRAM and 512Kb Flash memory, and is the cheapest and most readily available DSP chip. The functional block diagram of the 5510 DSP Starter Kit (From TMS320VC5510 DSP Data Manual) is shown in Figure 1.

In this project, apart from the CPU, largely only the services of the bottom right hand corner components - the McBSP, timers, GPIO and clock generation peripherals, will be required.
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Figure 1: Functional Block Diagram of TMS320VC5510

3.0 Integrated Development Environment
3.1. Code Composer Studio Overview
Code Composer Studio is a powerful, integrated development tool for DSP software. It is the preferred IDE for the Texas Instruments DSP starter kits, and is a project-oriented tool, allowing the user to think at the application level while it co-ordinates the build process. It has a powerful make utility, which, coupled with the integrated editor, allows the code to be edited and recompiled quickly and efficiently.
3.2. Project Creation
A project file had to be created first before any code could be implemented. Assuming the DSP board is connected to the computer and Code Composer has been installed, a project file was created by choosing New from the Project menu, then filling in the appropriate fields and setting the Target field to TMS320C55XX. Code Composer created a pjt file which stores the project settings and references various files used by the project. Source files, linker files and library files could then be added to the project by choosing Project -> Add Files to Project. Note that header files do not need to be added to the project as Code Composer scans the dependencies automatically.
3.3. Configuration Files
Configuration files were required in order to use the DSP/BIOS API. They define objects and their properties for the application program. Configuration files were created by choosing File->New->DSP/BIOS Config. This allowed a template for the C55XX to be displayed, and various module configurations to be made. After saving this configuration file, the following files were generated:

· xxx.cdb. Stores configuration settings

· xxxcfg.cmd. Linker command file

· xxxcfg.h. Includes DSP/BIOS module header files and declares external variables for objects created in the configuration file

· xxxcfg.s55. Assembly language source file for DSP/BIOS settings

· xxxcfg.h55. Assembly language header file included by xxxcfg.s55
· xxxcfg_c.c. Code for Chip Support Library (CSL) structures and settings
3.4. Loading program into DSK
Loading the program into the DSK involved building the project before loading the project. Choosing Project->Build would build the project and create .out file in the /Debug folder. File->Load Program would then load the program into the DSK, and choosing Debug->Run would run the program. 
4.0 Scanning sub-system

The scanning sub-system consists of a linear sensor array and a flash circuitry for illumination. As mentioned before, details of the flash circuitry will not be discussed here but can be obtained from the thesis by Sin Ying Lim. 
4.1. The TSL208 Linear Sensor Array

The linear sensor array chosen was the TSL208, largely because previous implementations used this sensor array and its operations proved adequate. The sensor is intended for use in a wide variety of applications including contact imaging, mark and code reading, barcode reading, edge detection and positioning, OCR, level detection, and linear and rotational encoding. Since in this project, it is required of the linear array to simply scan the light intensity passing through a polymer note, it is sufficient to use a linear array such as this. 
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The TSL208 linear sensor array consists of 512 photodiodes, each with associated charge amplifier circuitry, aligned to form a contiguous 512 x 1 pixel array. Operation of the sensor array is simplified by internal logic that requires only a serial-input (SI) pulse and a clock. The operational timing waveform details are shown in Figure 2. 
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Figure 2: CCD Array and Operational Timing Waveforms

The CCD scanner was used to retrieve the analogue data of the amount of light passing through the scanner and these voltages were shifted out to Analogue Output (AO). These voltages were then passed through a voltage comparator circuit (discussed in Sin Ying Lim’s thesis) whose output provided two levels of voltages, one for a dark pixel and one for a white pixel. The CCD scanner outputs a serial output (SO) signal at the end of the 512 pixels. These voltages were then fed back and stored in memory via the McBSP peripheral, discussed in section 6.0.
4.2. Scanning Constraints
From the software point of view, there were a few operating constraints put upon the project by the scanning hardware. 

· Clock Frequency – between 5kHz and 2MHz.
· Sensor Integration Time – between 0.2565 and 100ms. 

There were also a few timing constraints for the clock and SI pulses, and these are summarized in the Table 1:

	Timing Requirement
	Min
	Max
	Unit

	Serial Input setup time
	20
	
	Ns

	Serial Input hold time
	0
	
	Ns

	Clock Pulse Duration
	50
	
	Ns

	Input Transition (rise and fall) time
	0
	500
	Ns


Table 1: TMS320VC5510 DSP timing requirements
All these constraints had to be taken into account when programming the DSP board so as to ensure the integrity of data scanned and stored in memory. 
5.0 Timers/Clocks sub-system

The C5510 DSK has two identical but independent copies of a general purpose (GP) 20-bit software programmable timer. They were used for generating two signals used by the currency identification system, namely the CCD clock and the SI line. The block diagram of this GP timer is shown in Figure 3.  The importance of using this approach will be discussed in the individual sub-sections that follow.
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Figure 3: Conceptual Block Diagram of the General Purpose Timer

5.1. Generating a CCD Clock
As mentioned in the previous section, there was a constraint put on the operating frequency of the clock that was fed into the CCD linear array. The maximum frequency that the linear array can take is 2MHz, however the CPU clock of the TMS320VC5510 runs at 200MHz. This called for a clock divider concept such that the clock could be divided to ensure correct operation of the linear array. There were several ways clock division could be achieved:
· Using the 5510 System Register

· Configuring the TIN/TOUT pin
5.1.1. Approach 1 - System Register (SYSR)

The C5510 System Register provides control over certain device-specific functions. SYSR is located at port address 07FDh and its bit layout is shown in Figure 4.
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Figure 4: System Register (SYSR) Bit Layout
From here, it can be seen that bits 2-0 (CLKDIV) could have been used to divide the internal CPU clock by a specified factor and output it to the CLKOUT pin of the DSK. However, careful examination of data manuals had rendered this approach undesirable. Consider the CPU clock. It is running at 200MHz, but an operating clock of 2MHz was required. This required a CLKDIV factor of 100. Examining Table 2, because CLKDIV is represented by 3 bits, the maximum CLKDIV value is 111, which would only divide the CPU clock by 14. This would result in a clock frequency of about 14MHz, which would still be too fast for the CCD scanner to handle.  
	CLKDIV value
	Clock present on CLOCKOUT pin

	000
	CPU clock divided by 1

	001
	CPU clock divided by 2

	010
	CPU clock divided by 4

	011
	CPU clock divided by 6

	100
	CPU clock divided by 8

	101
	CPU clock divided by 12

	111
	CPU clock divided by 14


Table 2: Valid System Register CLKDIV values
5.1.2. Approach 2 – General Purpose Timer
The second approach for generating a CCD clock is by using one of the two general purpose timers. For the general purpose timer, the DSP contains the 4 registers, listed in Table 3 with their corresponding port addresses. The bit layouts of these registers are provided in Appendix B. 
	Port Address
	Register Name
	Description

	0x1000
	TIM0
	Timer 0 Count Register

	0x1001
	PRD0
	Timer 0 Period Register

	0x1002
	TCR0
	Timer 0 Timer Control Register

	0x1003
	PRSC0
	Timer 0 Timer Prescaler Register


Table 3: DSP General Purpose Timer Registers
The general purpose timer has one pin, which can be configured in 4 ways. The two FUNC bits in the timer control register (TCR) define the function of the timer pin and determine the required clock source for the timer. These configurations are summarized in Table 4. 
	FUNC Bits
	Timer Pin Function
	Clock Source

	00b
	None

The pin is in the high impedance state
	Internal

(from DSP clock generator)

	01b
	Timer output

The signal on the pin changes each time the main counter decrements to 0. The signal polarity is selected by the POLAR bit, and the signal toggles or pulses, depending on the CP bit. If pulsing is selected, the pulse width is defined by the PWID bits.
	Internal

(from DSP clock generator)

	10b
	General-purpose output

The signal level on the pin reflects the value in the DATOUT bit.
	Internal

(from DSP clock generator)

	11b
	External clock input

The pin receives a clock signal from a source outside the DSP
	External


Table 4: FUNC bit configuration for the general purpose timer
Generating a clock for this project therefore made it necessary for the timer pin to be configured in timer output mode, by configuring the TIN/TOUT pin to reflect the timer output (TOUT) as can be seen in Figure 3. When configured as output, the CP, POLAR and PWID bits define the properties of the output. CP controls whether the TOUT pin functions as a pulse or a clock. CP was configured in clock mode, where the timer output signal toggles each time the main count register (TIM) counts down to zero. When this timer counts down to zero, an interrupt signal (TINT) could be sent to sent to the CPU which will set a flag in one of the interrupt flag registers. However, this was deemed unnecessary as the timer could also be configured in auto-reload mode. Here, the prescaler and the timer counter are reloaded automatically once the timer counts down to zero. This method allows the general-purpose timer to count continually without input from the application program. Therefore, this method was chosen over the interrupt generation method. 

Configuration of the timer required two main steps:
1. Initialising the timer – this step involved a procedure to ensure that the general purpose timer was configured correctly. The following procedure was employed:
· The TSS bit of the Timer Control Register (TCR) was set to 1 to ensure the timer was stopped before configuration.
· Timer loading was enabled, which loaded period registers into the count registers.
· The other control bits in TCR were set.
·  The prescaler and main counter periods were written into the appropriate registers. 
· Timer loading was disabled.
2. Starting the timer – after configuration and proper initialisation of the timer, the TSS bit was set to 0 so that the timer could start running.  
The exact procedure that was used for generating the 2MHz clock on the TOUT1 pin is explained in detail below:

· Configured TOUT1 pin as timer output by setting FUNC field in TCR to 01b.
· Timer pin was operated in clock mode (50% duty cycle) by setting CP field in TCR to 1b. This causes the pin to toggle each time the timer count counts down to zero. 

· The polarity of the signal pin on start up was set to 0b (low).

· Since the TOUT1 pin toggles each time the timer count counts down to zero, the total period of the output clock is twice the count value that is written to the timer. Since a 2MHz clock was required from a 200MHz clock, this required a division of the CPU clock frequency by 100, a total timer count of 50 is required for each high and low cycle. The timer period was therefore set to 10 (PRD register to 9) and the prescaler to 9 (TDDR = 4) to achieve this. 

· Auto reload (ARB = 1) allows the timer to automatically reload the count and start again each time the counter counts down to zero. 
· The TSS bit in TCR was then set to 0 so that the timer could start operating at the required frequency. 

· The resulting pulse from the TOUT1 pin was then wired and fed into all other peripherals that required a clock, such as the CCD scanner and the McBSP so that all the components of the system were running at the same clock frequency which would enable consistent operation. 

5.2. Generating a Serial Input (SI) Line
A Serial Input line was required for both the scanner sub-system as well as the data acquisition sub-system, so as to provide some sort of synchronisation mechanism for initiating certain operations. As mentioned before, the CCD scanner requires a serial input line to initiate the shifting of analogue output voltages. All that is required by the system is to generate a single pulse after 513 clock cycles. Generating a single pulse can be done by one of the following two ways.

5.2.1. Approach 1 – General Purpose I/O

The C5510 provides eight general purpose input/output (GPIO) pins, IO1 – IO7. Each pin is independent of all others and can be configured as an input or output pin using the I/O Direction Register (IODIR). The I/O Data Register (IODATA) is used to control the states of these pins. To generate a single pulse using the GPIO seemed to be the most straightforward way. All that was required was to configure a GPIO pin as an output pin, and control the logic state of the pin by writing 1 or 0 to the corresponding bit in the IODATA register. Then, one could write a 1 to the IODATA register, set a delay to satisfy the settling time of the CCD scanner (20ns), then write a 0 to the IODATA register until 513 clock cycles later where the process repeats itself. 

However, there were two main difficulties with this approach. Firstly, it this method did not satisfy the integration time of the CCD scanner. The integration time is defined as the time between the first and second read of the first pixel in the array, which is the duration that charge is allowed to accumulate in the charge sites of the CCD scanner. If this timing requirement is not satisfied, the pixels in the CCD saturate and would result in undesirable scanning output. One way to solve this was to find some way of continuously sending an SI line to the scanner, but only reading the data when it was required, so that the scanner would operate correctly. However, this caused a second problem. To be feeding the SI line to the scanner continuously would require this operation to be run independently from the actual flow of control of the software program itself, as simply performing the operation in a loop is insufficient to guarantee that the integration time of the scanner could be satisfied. 
5.2.2. Approach 2 – General Purpose Timer

As mentioned before, the C5510 has 2 identical general purpose timers which could be used. Since the first one was taken up by clock generation, it was decided that the second timer would be used for the generation of the SI line. Configuring the timer to produce a periodic pulse on the TOUT pin required a similar approach to the clock generation mentioned above, except that the pin operates, in this case, in pulse mode, as opposed to clock mode in the generation of the clock. The exact procedure used to generate the SI line is detailed below:
· Configured TOUT0 pin as timer output by setting FUNC field in TCR to 01b.
· Set TOUT0 pin to operate in pulse mode by setting CP field on TCR to 0b. The pin produces a single pulse each time the timer count counts down to zero. 

· The polarity of the signal pin on startup was set to 0b (low). 

· A pulse had to be generated such that it satisfied the Serial Input setup and hold times of 20ns. 

· CPU clock frequency = 200MHz =>
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, therefore a serial input pulse width of at least 4 clock cycles was required. It was thus decided that an 8-cycle wide output pulse was to be generated by setting the PWID field in TCR to 11b. 

· Knowing that the CCD integration time had to be between 0.2565 and 100ms, and providing a leeway to compensate for timing discrepancies, it was decided that a value of around 0.3ms would be used. This value had to be as small as possible, as it would mean that the number of scans obtained would be maximised. A period of 0.3ms equates to about 3KHz, so to generate a 3KHz period from a 200MHz CPU clock, the timer must count (200, 000, 000 / 3, 000) = 67,000 CPU clock cycles between output pulses. However, as integers are stored in 16 bits, 65,536 is the maximum value. Using a timer count of 65,536 clock cycles would produce a frequency of 3.051KHz, so this value was used in the implementation as the frequency obtained fell in an acceptable range. 
· A divide down of 65,536 clock cycles was achieved by setting the timer period to 65,536(PRD = 0xFFFF), with a prescaler of 1 (TDDR = 0).
· As with the clock generation, the timer was configured in auto-reload mode so that the count was reloaded and restarted automatically. 
6.0 Data Acquisition sub-system

After the scanning of the currency note is performed, there has to be a method of collecting this scanned data and feeding it back into the DSP board so that the image recognition algorithm could be applied to the data. The TMS320VC5510 DSP provides multi-channel buffered serial ports (McBSPs) that allow the direct communication between the CPU and other components within the system. The McBSP offers many features, of which the relevant ones to this project are listed below:
· Double buffered transmission and triple-buffered reception, which allows a continuous flow of data between devices communicating via the McBSP.

· Independent clocking and framing for both data reception and data transmission. 

· Support for external generation of clock signals and frame-synchronization (frame-sync) signals

· Various selections of data sizes: 8, 12, 16, 20, 24 and 32 bits.

For the TMS320VC5510, there are three available McBSPs, namely, McBSP0, McBSP1 and McBSP2. However, the DSK uses a Texas Instruments AIC23 stereo codec for input and output of audio signals, and McBSP1 is usually reserved for the control of the codec’s internal configuration registers and McBSP2 is usually used as the bi-directional data channel for the audio codec. This leaves McBSP0 that can be used as a generic data communication channel. Although the McBSP offers full duplex communication, McBSP0 was only used as a data acquisition or reception channel in this project. The functional block diagram (taken from TMS320VC5510 DSK Technical Reference) of the McBSP0 is shown in Figure 5.
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Figure 5: Block Diagram of the McBSP
6.1. McBSP receive operation

There are several pins associated with the data and control functions of the McBSP, which can be seen in Figure 5.  The pins of interest to the project, as well as their possible states and uses, are tabulated in table 5. 

	Pin
	Possible States
	Use

	CLKR
	I/O/Z
	Supplying the receive clock

	DR
	I
	Receiving serial data

	FSR
	I/O/Z
	Supplying the receive frame synchronisation signal


Table 5: McBSP receive interface pins

Observing Figure 5 will explain the data reception process of the McBSP. The process is summarised below:
· The McBSP waits for a frame synchronisation pulse (whose function will be explained in Section 6.3).

· Data arrives on the DR pin and is shifted into Receive Shift Registers (RSR1 and/or RSR2).
· After a full word has been received, the contents of the Receive Shift Registers are then copied to the Receive Buffer Registers (RBR1 and/or RBR2), but only if these buffer registers are not already full with previous data. 

· The contents of the RBRs are then copied to the Data Receive Registers (DDR1 and/or DDR2), but only if these data receive registers have empty slots caused by previous data having been read by the CPU or DMA controller.
· When the Data Receive Registers receive new data, the receive ready bit (RDDY) is set in the SPCR1 register, which indicates that data is ready to be read by the CPU or the DMA controller. 

· After the CPU or DMA controller has read the Data Receive Registers, the RDDY bit is cleared, which initiates the next RBR-DRR copy. 

By the above method, data integrity is maintained as data is never overwritten due to the triple buffering of the McBSP. This was the very reason the McBSP was chosen as the preferred method of data acquisition for this project. 
6.2. McBSP clocking

The clocking mechanism of the McBSP was an important consideration in the McBSP. Receive data is shifted one bit at a time from the DR pin to the receive shift registers and these bit transfers are controlled by the clock edges of a clock signal. There were two ways in which this clock signal could have been derived:

1. Internal McBSP clock – Each McBSP has its own sample rate generator that can be used to generate an internal clock.
2. External McBSP clock – This external clock (CLKR) can be fed to a pin at the boundary of the McBSP.
For synchronisation purposes and ease of implementation, an external clock was supplied to the McBSP. This was the clock described in Section 5.1. On the TMS320VC5510, the McBSP has a maximum frequency of ½ the CPU clock frequency. Using the external clock (of 2MHz) does ensure that this timing requirement is satisfied. Figure 6 shows the timing diagram of an example of the McBSP receiving 8-bit data using an external clock and external frame synchronisation signal. 
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Figure 6: Timing diagram example of  8-bit serial word data
6.3. McBSP Frame Synchronisation

From Figure 6, note that the bits passing through the shift registers (RSR) and the data pins (DR) are transferred in serial word size groups. This means that bits coming in on the DR pins are not transferred from the shift registers to the buffer registers until a full serial word has been received. This size is user specified. For this project, it was decided that the serial word size was to be specified as 16-bit. This is because 16-bits is a convenient size to work with, since data is addressable in 16-bit words for the C55x family of DSPs. 

There is also the concept of a frame. A frame is defined as the number of serial words transferred in a continuous stream at any one time. However, the frames do not have to be transferred in a continuous fashion – there may be breaks between frames being received. The McBSP uses frame synchronisation signals to determine when each frame should be received. When the McBSP detects a frame synchronisation signal, it begins receiving a single frame of data. When the next pulse occurs, it receives the second frame, and so on. Figure 6 shows the receive frame-sync (FSR) signal that initiates the transfer of frames on the DR pin. Like the serial word size, the frame size of the McBSP is also user defined. Since the CCD scanner is a 512x1 linear array, it was required that 512 bits of data had to be retrieved. Since it was defined that the serial word size was to be 16-bit, the frame size was chosen to be 32-words long, as 32 frames of 16 bit words would retrieve a total of 512 bits.     
6.4. McBSP Receiver Configuration

With the above design decisions, the McBSP had to be configured to allow data reception to be performed according to the project’s needs. Configuring the McBSP receiver involved three main steps:
1. The McBSP was put in reset mode – this involved setting the RRST bit in SPCR1 to 0. 

2. The McBSP registers were loaded with desired values

3. The McBSP was taken out of reset mode – this involved setting the RRST bit in SPCR1 to 1 to enable to serial port receiver. 
The most involved step in the configuration process was step 2 – register loading. Appendix C shows the relevant McBSP registers used for this project. One or more of these registers were used in configuring the following component behaviours:
· Global McBSP behaviour – this includes enabling and disabling digital loopback and clock stop modes, as well as multi-channel selection modes.
· Data behaviour – this includes setting the word and frame lengths as detailed in Section 6.3, as well as other functions pertaining to the nature of the data received by the McBSP.
· Frame Synchronisation behaviour – the setting of the receive frame-sync mode and polarity.
· Clocking behaviour – the setting of the external clock mode and polarity.
6.4.1. Global McBSP behaviour
Global McBSP behaviour characterises the way in which the McBSP module functions as a whole.  Four tasks were essential in ensuring the global behaviour of the McBSP module performed according to the project’s aims.

1. Setting the function of the receiver pins – the receiver pins could be programmed to function either as McBSP pins or general purpose I/O pins. The Receive I/O Enable (RIOEN) bit of the PCR register was set to 0b to configure the DR, FSR, CLKR and CLKS pins to function as serial port pins. 
2.  Digital loopback mode – in digital loopback mode, the receive signals are multiplexed and looped back to the transmit signals, such that the McBSP receives the data it transmits. This is useful in that the McBSP can be put into the loopback mode to test its correctness. During testing, the McBSP was put into digital loopback mode, however for the proper operation, the digital loopback mode was disabled by setting the Digital Loopback (DLB) bit of the SPCR1 register to 0b. 
3. Clock stop mode – in clock stop mode, the clock stops after every transfer. As it is undesirable to do so in this project, clock stop mode was disabled by setting the CLKSTP field in the SPCR1 register to 00b.

4. Receive multi-channel selection mode – in multi-channel selection mode, channels can be individually enabled or disabled. Like the clock stop mode, this was unnecessary in this project, therefore multi-channel selection mode was disabled by setting the RMCM bit in the MCR1 register to 0.     
6.4.2. Data behaviour

A total of eight tasks constitute the nature and behaviour of the data received by the McBSP.

1. Receive Frame Phases – the receive data frame can be configured to operate as a single phase or as two phases. A single phase is sufficient to hold the data for this project, so the RPHASE bit of the RCR2 register was set to 0 to set a single phase frame.

2. Setting the receive word lengths – As mentioned before, the size of the word length was set to be 16 bits. This was achieved by setting the RWDLEN field of the RCR1 register to 010b. The RWDLEN field in RCR1 specifies the word length for the single phase mode. If two phases are used, the RWDLEN field in RCR2 could be used also. 

3.  Setting the receive frame length – Also mentioned before was the size of the receive frame, which holds a specified number of serial words. It was decided in this project to use a frame length of 32 so that 32 frames of 16-bit words gave 512 bits. This was achieved by setting the RFRLEN1 field of RCR1 to 31 (0011111b). Note that the value written into this field is one less than the desired value. For example, if a phase length of 128 words was required, RFRLEN1 had to be loaded with the value of 127.

4.  Receive frame-sync ignore function – Sometimes the frame synchronisation pulse would initiate the next transfer of a frame before the current frame has been fully received. This unexpected frame synchronisation pulse could be ignored. This was a desirable function in the project as it would maintain data integrity. Unexpected pulses were ignored by setting the RFIG bit in the RCR2 register to 1. This would cause the current reception to continue, ignoring the unexpected pulses. 
5. Setting the receive companding mode – The data received by the McBSP could be compressed, expanded, or neither. This was not required by the project and was therefore disabled by setting the RCOMPAND field of the RCR2 register to 00b. 

6. Setting the receive data delay -  the receive data delay refers to the delay of the actual reception of the data, with respect to the start of the frame, which is defined as the first clock cycle after the frame synchronisation pulse is received. For intuitive purpose, the data delay for the project was chosen to be 1-bit, so that the data follows 1 cycle after the frame synchronisation pulse is received. This was achieved by setting the RDATDLY field of the RCR2 register to 01. 
7. Setting justification mode – the RJUST field of the SPCR1 register was set to 00 so that data was right justified and the most significant bits were zero filled. 
8. Setting receive interrupt mode – when data is ready to be read by the CPU or DMA controller, the RRDY bit of SPCR1 is set. It could be specified that at the receipt of this event, the receive interrupt signals the CPU. This was the case used by this project, however many other events could have been specified to trigger an interrupt.  

6.4.3. Frame Synchronisation behaviour

The frame synchronisation pulse initiates the transfer of data. As mentioned before the Serial Input line that was fed into the CCD scanner was also fed into the McBSP module so that events were synchronised. This means that once the scanner had started scanning, the McBSP would start receiving it, thereby ensuring data integrity. For the McBSP, only two tasks were required to specify the frame synchronisation signal. 
1. Setting the frame synchronisation mode – this determines the source of the frame synchronisation signal, and sets the properties of the pulse. This step involves the combinations of the states of bits that might have previously been set. Firstly, the receive frame synchronisation mode (FSRM) bit of the PCR register had to be set to 0b to specify that the frame synchronisation signal would be supplied by an external source. However, the behaviour of the frame synchronisation signal also depends on the values of the DLB and CLKSTP fields in the SPCR1 register, as well as the GSYNC bit of the SRGR2 register. Different combinations of these bits would result in the FSR pin being in different states, as specified in Table 6. Recall that the DLB bit was set to 0b before this, and the FSRM was set to 0b. Regardless of the GSYNC value (being a don’t-care), the FSR pin functions as an input pin with the source of the pin being an external one on the FSR pin. 

	DLB
	FSRM
	GSYNC
	Source of frame synchronisation
	FSR pin status

	0
	0
	X
	External signal on FSR pin
	Input

	0
	1
	0
	Internal FSR driven by sample rate generator
	Output

	0
	1
	1
	Internal FSR driven by sample rate generator
	Input

	1
	0
	0
	Internal FSX drives internal FSR
	High Impedance

	1
	X
	1
	Internal FSX drives internal FSR
	Input

	1
	0
	0
	Internal FSX drives internal FSR
	Output


Table 6: Effect on FSR pin with different combinations of register bits

2. Setting the frame synchronisation polarity – The FSRP bit on the PCR register simply determines if the frame-sync pulses are active high or active low. It was taken to be active high by setting the FSRP bit to 0, simply because the other subsystems take this synchronisation pulse as being active high as well, so the decision was based on the idea of uniformity. 
6.4.4. Clocking behaviour

The clocking behaviour of the McBSP is simplified because of the fact that an external clock is being fed into the module. If the sample rate generator (SRG) was used to generate this clock, there would be several other tasks involved such as setting the SRG clock divide-down value, as well as the SRG clock synchronisation mode and polarity. Without the sample rate generator, there were only two tasks that needed to be tackled. 
1. Setting the receive clock mode – As with the frame-sync signal, a number of different bits govern the overall characteristics of the CLKR pin. These include the CLKRM bit in the PCR register, as well as the DLB and CLKSTP bits in SPCR1. These combinations are shown in Table 7. Since the CLKR pin had to be configured as an input pin for the purposes of this project, this was achieved, as can be seen from table 7, when the CLKRM bit in the PCR register was set to 0.
	DLB
	CLKRM
	Source of receive clock
	CLKR pin status

	0
	0
	External clock on CLKR pin
	Input

	0
	1
	Sample rate generator drives CLKR
	Output

	1
	0
	Internal CLKX (transmitter clock) drives CLKR
	High Impedance

	1
	1
	Internal CLKX (transmitter clock) drives CLKR
	Output


Table 7: Effect on CLKR pin with different combinations of register bits
2. Setting the receive clock polarity – The CLKRP bit of the PCR register simply determines the polarity of the receive clock. This bit was set to 0 so that when CLKR was configured as an input, the external CLKR was not inverted before being used internally. 

7.0 System Integration and Testing
7.1. System Integration

With the design and implementation of the system components detailed in the previous sections, they were brought together and integrated as a system. A high-level block diagram of the project as a system can be seen in Figure 7. As mentioned before, the image recognition component was deemed to be outside the scope of this project. An image of the setup of the system is shown in Appendix E. 
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Figure 7: Integrated System Block Diagram
The integration of the system involved tying together the individual system components, with additional program logic. The main program logic of the system can be considered rather straightforward. A high level pseudocode of the system is shown here:

[image: image35.png]



     START     
  INITIALISE system
  GENERATE clock and SI signal

  ENABLE data acquisition module

  WHILE “finished” button not pressed

     SET scan count to zero


 WHILE maximum scan count not reached

      
READ a scan

      
IF scan is valid




INCREMENT scan count



END IF


END WHILE


RECOGNISE note


OUTPUT results

  END WHILE
  DISABLE data acquisition module

  END

Although the pseudocode of the main program is sufficient in providing an understanding of the program logic, more often than not, a diagrammatic representation is easier to understand. A more detailed program flowchart is provided in Figure 8 to illustrate the data and control flow of the program. A few components require further explanation. These components are detailed below:
· Initialise System – This step required declaring register addresses, initialising the board support library for board components such as the LEDs and the DIP switches, as well as initialising the chip support library for chip components such as the McBSP. 

· Generate clock and SI signal – This step included routing the CPU clock to the TOUT pin, and generating the clock and serial input lines.

· Enable data acquisition module – Using the McBSP firstly required one of the McBSP ports to be opened, which returned a McBSP handle that was used for other chip support library functions. The McBSP module provides a configuration structure where the programmer can fill in the structure values to write to the McBSP control registers. This step required this structure to be filled in, followed by the frame synchronisation to be started, and finally to enable the receive function of the McBSP. 
· “Finished button” – this button is defined as the 2nd DIP switch on the DSK. 

· Maximum scan count – this value is defined in the header file and can be easily changed by setting the desired value. For reliability purposes, about 10 scans would be needed to identify the note with an acceptable degree of accuracy.
· Read a scan – this step was handled by the read_single_scan( ) function. This function takes in, as an argument, a pointer to a buffer array that holds each scan. The function fills in this buffer, 16 bits at a time, as long as the serial output line of the CCD scanner is not set, which indicates that the scanner is still in the process of scanning. The algorithm below shows the way in which a single scan is performed:




IF SO line not set




FOR i is 0 to size of buffer





WHILE 16-bit transfer not complete






DO nothing





END WHILE





SHIFT values out from data receive





registers to scan buffer




END FOR



IF scan is valid





RETURN success




ELSE 





RETURN failure




END IF



ELSE




RETURN failure



END IF

· Scan validity – a scan is deemed valid if it contains at least 10 dark pixels. A scan containing only white pixels would mean that the scanner had not scanned anything, while a scan containing only one or two pixels dark pixels could mean an error or a glitch in the scanning. When too few pixels are scanned, not enough information is available to accurately determine the note, therefore it is not considered a valid scan. 
Appendix D shows the full source code of the main program, together with the individual functions called by the main program, as well as the include header file that is required by the program.

7.2. System Testing

Testing of the system from a software point of view has always been more difficult for an embedded system such as this, compared to a high-level software application. The DSK provides many functions and features for effectively and efficiently debugging and testing code, such as usage of the watch window for checking of variable values, an option to allow the user to view the contents of a memory location, allowing the user to print statements to a log window (similar to printf), and it also includes four LEDS and four DIP switches as a simple way to provide users with interactive feedback. 
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Figure 8: DSP Software Flowchart
8.0 Implementation results

8.1. 2MHz Clock Generation Output

A clock of 2MHz frequency was generated as described in section 5.1. The result from this can be seen in the CRO output in Figure 9. 

[image: image12]
Figure 9: CRO output of 2MHz clock
8.2. Synchronisation Signal (Serial Input line) Output
The synchronisation signal used as both the serial input line for the CCD scanner as well as the frame synchronisation signal for the McBSP is shown as trace 1 in Figure 10. Trace 2 shows the Serial Output signal generated by the scanner after 512 pixels. 

[image: image13]
Figure 10: CRO output of Serial Input and Serial Output signals

Figure 11 shows the CRO output when the scanner is ready to scan. Trace 2 shows the serial input line which starts shifting analogue information out of the Analogue Output pin, and trace 1 shows the Analogue Output of the scanner not scanning anything. This figure serves to show that the serial input line is indeed working, as the analogue output signal is only valid once the serial input line is generated. 
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Figure 11: CRO Output of scanner in ready mode
8.3. Scanning Output

The validity of the scanning subsystem can be shown in the following figures. In Figure 12, Trace 2 is once again the serial input line. Trace 1 is the analogue output produced when the scanner is scanning some non-opaque material. Note that some light is allowed to pass through the material, which may give erroneous bit level values once the values pass through the voltage comparator circuit. 


[image: image15]
Figure 12: CRO Output of scanner scanning non-opaque material
However, Figure 13 shows the output of the scanner scanning a solid opaque material. Here, the bit level values are more reliable. This experiment shows that there may be erroneous bit level values fed back into the DSP chip, since some light may have been allowed to pass through a thin polymer dollar note. This implies that the image recognition algorithm should allow for a margin of error to handle this situation.
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Figure 13: CRO output of scanner scanning opaque material

Figure 14 shows the CRO output when the scanner is scanning through a 50 dollar note across two stars in the clear window, as shown in Figure 15. The CRO output shows only the clear window of the scanned note, as this is the only area of the note which contains useful information. The two peaks in the output correspond to the two stars, while the two outer edge dips correspond to the clear area on the outside edges of the two stars. The dark edges outside of this correspond to the white window borders. Note here that light is allowed to pass through the white areas of the note slightly, which may produce erroneous bit level values due to the voltage comparator circuit wrongly interpreting the voltage levels.  
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Figure 14: CRO output of scanner scanning a 50 dollar note

[image: image18]
Figure 15: Scanner over 50 dollar note

9.0 Conclusion
As a daily aid for the blind or a visually impaired person, a small hand held device for currency identification such as the one proposed for this project would significantly improve the quality of life for these people. Not only will they be more confident in handling money on a daily basis, a device such as this would decrease the likelihood that visually impaired people are unfairly treated such as getting short changed. In this section, the objectives achieved and contributions made by the student to the overall project, as well as some recommendations for future work are detailed. 
9.1. Objectives Achieved
This project identifies and addresses some key issues in order to achieve its objectives. From a software point of view, the system should not only be reliable, efficient and timely, but should also cause the system to be fairly easy to use since most of the users would be suffering from a visual and often tactile disability. This was taken into consideration in the software implementation of the system, as the program only required the user to press a button or a switch to indicate that he or she has finished using the device, assuming that there is some method available for initiating the program, such as a power button on the device. 
To be reliable and efficient largely relies on the recognition algorithm to be accurate, as well as the CCD scanner to be sufficiently sensitive to its inputs. Timeliness is assured as all clock sources are generated from the one source, and all synchronisation sources were generated from the one source as well. 

The software developed by this part of the project essentially performs all the tasks of the proposed system up to and including the storing of bit values into memory locations within the DSK. The image recognition algorithm can then be applied to the contents by simply addressing the memory locations. 
Software development on the TMS320VC5510 forms a significant part of this project. The software itself drives the hardware to acquire data, which called for close collaboration with Sin Ying Lim, the student working on the hardware aspects of the project. The image recognition algorithm developed by Siang Jin Ting also required porting from MATLAB to the C, which once again deemed it necessary to work with a student who had some familiarity with the DSP board. Therefore, the contribution to the overall project by this student is believed to be of substantial value. 
9.2. Recommendations for Future Work
9.2.1. McBSP power management

From the DSP flowchart of the program shown in Figure 8, it can be seen that the McBSP data acquisition module keeps running throughout the lifetime of the program even though it may not necessarily be utilised. The McBSP may be put in idle mode with reduced power consumption. In idle mode, if the McBSP is configured to operate with externally generated clocking and frame synchronisation as it is in this project, the external interface portion of the McBSP continues to function during periods of external clock activity. The McBSP sends a request to activate idle domains when it needs to be serviced. This will greatly reduce power consumption of the system and may be beneficial to the project if explored.  
9.2.2. Improved CCD scanner
Although the current CCD scanner used has sufficient capabilities to get the job done, a wider range of scanners could be explored. As the maximum frequency the CCD scanner can take is 2MHz whereas the board supports speeds up to 200MHz, the speed of the CCD scanner becomes a hindrance to the overall performance of the system. A faster CCD scanner could obtain more scans in a given period of time, thereby increasing the reliability and efficiency of the system. A more sensitive CCD scanner would also give better results with respects to the amount of erroneous bit levels mentioned in section 8.3. 

9.2.3. Memory Management

The issue of memory management often crops up in embedded systems. In this project, the issue of storing template files for every row of a note window is a rather inefficient method. Given the C5510 DSK only provides 8MB of synchronous DRAM and 512KB of non-volatile flash memory, minimising the amount of memory space used is crucial. Also, the system acquires data from the scanner and stores this data as 16-bit integers, even though they only potentially take up one bit (the image recognition algorithm works on bits of 0 or 1). This method of storing scans is very wasteful of memory space. However, there exists no one-bit data type in C. The concept of “bit arrays” can be applied here, where a set of macros can be used to declare an array of any number of desired bits (DCube Software Technologies, 2002). 
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Appendix B – Bit layouts of timer registers
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Appendix C – Bit layouts of McBSP registers
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Appendix D – Program Source Code

/*****************************************/
/* main.c                                */
/* Source code for the main program      */
/*****************************************/

#include "cur_scan.h"

//log object for debugging purposes
extern LOG_Obj trace;

//for GPIO

volatile ioport unsigned int *IODIR;

volatile ioport unsigned int *IODATA;

//for clock

volatile ioport unsigned int *TIM1;

volatile ioport unsigned int *PRD1;

volatile ioport unsigned int *TCR1;

volatile ioport unsigned int *PRSC1;

//for SI line

volatile ioport unsigned int *TIM0;

volatile ioport unsigned int *PRD0;

volatile ioport unsigned int *TCR0;

volatile ioport unsigned int *PRSC0;

//for McBSP0

volatile ioport unsigned int *DDR10;

volatile ioport unsigned int *SPCR10;

volatile ioport unsigned int *SPCR20;

volatile ioport unsigned int *PCR0;

volatile ioport unsigned int *RCR10;

volatile ioport unsigned int *RCR20;

volatile ioport unsigned int *SRGR20;

volatile ioport unsigned int *MCR10;

/*-----------------------------------------------------*/
/* pointer to character buffers */
unsigned char *buf_ptr = (unsigned char*)0x28000;

// McBSP handler

MCBSP_Handle mhMcbsp;

/* Create a MCBSP configuration structure */

static MCBSP_Config Config16 = 

{


MCBSP_SPCR1_RMK


(



MCBSP_SPCR1_DLB_OFF,           /* DLB    = 0 */



MCBSP_SPCR1_RJUST_RZF,         /* RJUST  = 0 */



MCBSP_SPCR1_CLKSTP_DISABLE,    /* CLKSTP = 0 */



MCBSP_SPCR1_DXENA_NA,          /* DXENA  = 0 */



MCBSP_SPCR1_ABIS_DISABLE,      /* ABIS   = 0 */



MCBSP_SPCR1_RINTM_RRDY,        /* RINTM  = 0 */



0,                             /* RSYNCER = 0*/

0,                             /* RFULL = 0 N/A 










*/



0,                             /* RRDY = 0 N/A 










*/



MCBSP_SPCR1_RRST_DISABLE       /* RRST   = 0 */


),


MCBSP_SPCR2_RMK


(



MCBSP_SPCR2_FREE_NO,           /* FREE   = 0 */



MCBSP_SPCR2_SOFT_NO,           /* SOFT   = 0 */



MCBSP_SPCR2_FRST_FSG,          /* FRST   = 0 */



MCBSP_SPCR2_GRST_CLKG,         /* GRST   = 0 */



MCBSP_SPCR2_XINTM_XRDY,        /* XINTM  = 0 */



0,                             /* XSYNCER = N/A 










*/



0,                             /* XEMPTY = N/A 










*/



0,                             /* XRDY   = N/A 










*/            



MCBSP_SPCR2_XRST_DISABLE       /* XRST   = 0 */


),


MCBSP_RCR1_RMK


( 



MCBSP_RCR1_RFRLEN1_OF(31),     /* RFRLEN1 = 31 









   









  (11111) */



MCBSP_RCR1_RWDLEN1_16BIT       /* RWDLEN1 = 2 










*/


),


MCBSP_RCR2_RMK


(    



MCBSP_RCR2_RPHASE_SINGLE,      /* RPHASE  = 0 










*/



MCBSP_RCR2_RFRLEN2_OF(0),      /* RFRLEN2 = 0 










*/



MCBSP_RCR2_RWDLEN2_8BIT,       /* RWDLEN2 = 0 









     */



MCBSP_RCR2_RCOMPAND_MSB,       /* RCOMPAND = 0 










*/



MCBSP_RCR2_RFIG_NO,


 /* RFIG    = 1 










*/



MCBSP_RCR2_RDATDLY_1BIT        /* RDATDLY = 01 










*/

    ),  


MCBSP_XCR1_RMK


(    



MCBSP_XCR1_XFRLEN1_OF(0),      /* XFRLEN1 = 0 










*/ 



MCBSP_XCR1_XWDLEN1_32BIT       /* XWDLEN1 = 5 










*/


),   


MCBSP_XCR2_RMK


(   



MCBSP_XCR2_XPHASE_SINGLE,      /* XPHASE  = 0 










*/



MCBSP_XCR2_XFRLEN2_OF(0),      /* XFRLEN2 = 0 










*/



MCBSP_XCR2_XWDLEN2_8BIT,       /* XWDLEN2 = 0 










*/



MCBSP_XCR2_XCOMPAND_MSB,       /* XCOMPAND = 0 










*/



MCBSP_XCR2_XFIG_NO,            /* XFIG    = 0 










*/



MCBSP_XCR2_XDATDLY_0BIT        /* XDATDLY = 0 










*/


),            


MCBSP_SRGR1_RMK


( 



MCBSP_SRGR1_FWID_OF(1),        /* FWID    = 1 










*/



MCBSP_SRGR1_CLKGDV_OF(0)       /* CLKGDV  = 0 










*/


),   


MCBSP_SRGR2_RMK


(  



MCBSP_SRGR2_GSYNC_SYNC,        /* GSYNC   = 1 










*/



MCBSP_SRGR2_CLKSP_RISING,      /* CLKSP   = 0 










*/



MCBSP_SRGR2_CLKSM_CLKS,         /* CLKSM   = 0 










*/ 



MCBSP_SRGR2_FSGM_DXR2XSR,       /* FSGM    = 0 










*/



MCBSP_SRGR2_FPER_OF(15)         /* FPER    = 0 










*/


),  


MCBSP_MCR1_DEFAULT,


MCBSP_MCR2_DEFAULT, 


MCBSP_PCR_RMK


(



MCBSP_PCR_IDLEEN_RESET,         /* IDLEEN   = 0   










*/



MCBSP_PCR_XIOEN_SP,             /* XIOEN    = 0   









     */



MCBSP_PCR_RIOEN_SP,             /* RIOEN    = 0   










*/



MCBSP_PCR_FSXM_EXTERNAL,        /* FSXM     = 0   










*/



MCBSP_PCR_FSRM_EXTERNAL,        /* FSRM     = 0   










*/



MCBSP_PCR_SCLKME_BCLK,          /* SCLKME   = 1   










*/



0,                              /* CLKSSTAT = 









 N/A */



0,                              /* DXSTAT = N/A   










*/



0,                              /* DRSTAT = N/A   










*/



MCBSP_PCR_CLKXM_INPUT,          /* CLKXM    = 0   










*/



MCBSP_PCR_CLKRM_INPUT,          /* CLKRM    = 0   










*/



MCBSP_PCR_FSXP_ACTIVEHIGH,      /* FSXP     = 0   










*/



MCBSP_PCR_FSRP_ACTIVEHIGH,      /* FSRP     = 0   










*/



MCBSP_PCR_CLKXP_RISING,         /* CLKXP    = 0   










*/



MCBSP_PCR_CLKRP_RISING

  /* CLKRP    = 1   










*/


),


MCBSP_RCERA_DEFAULT, 


MCBSP_RCERB_DEFAULT, 


MCBSP_RCERC_DEFAULT, 


MCBSP_RCERD_DEFAULT, 


MCBSP_RCERE_DEFAULT, 


MCBSP_RCERF_DEFAULT, 


MCBSP_RCERG_DEFAULT, 


MCBSP_RCERH_DEFAULT, 


MCBSP_XCERA_DEFAULT,


MCBSP_XCERB_DEFAULT,


MCBSP_XCERC_DEFAULT,


MCBSP_XCERD_DEFAULT,  


MCBSP_XCERE_DEFAULT,


MCBSP_XCERF_DEFAULT,  


MCBSP_XCERG_DEFAULT,


MCBSP_XCERH_DEFAULT

}; 

/******************************************************/
/*                                                    */

/* Function  : read_single_scan(unsigned char *buf)   */

/* Use       : to read 512 pixels of data             */

/* Arguments : pointer to a buffer to hold data       */

/* Returns   : 0 on success, 1 on failure             */

/* 









    */
/******************************************************/
Uint16 read_single_scan(unsigned char *buf)
{


Uint16 temp, i, result;


/* masking variable */

temp = *IODATA & 0x40; 


/* SO line not set, read output */

if (temp != 0x40) 


{



/* read register values and store in buffer */


for (i=0; i<SCANBUF_SIZE; i++)



{
 



/* wait for 16-bit word transfer to complete */

     /* and shift values out from DDR accordingly */



while (!MCBSP_rrdy(mhMcbsp));




/* equivalent to out_buffer[i] */ 




*(buf+i)= MCBSP_read16(mhMcbsp);



}




/* check if valid scan */


if (valid_scan(buf) == 0)



{



/* successfully read 512 bits */



result = 0; 


}



else





result = 1;


}


else 

{



/* SO line set */


result = 1;


}



return result;

}

/******************************************************/
/*                                                    */

/* Function  : valid_scan(unsigned char *buf)         */

/* Use       : to check if buffer contains at least   */             /*             10 dark pixels                         */

/* Arguments : pointer to a buffer that holds data    */

/* Returns   : 0 on success, 1 on failure             */

/* 









    */
/******************************************************/
Uint16 valid_scan(unsigned char *in_buffer)

{


int i, count = 0;


for (i=0; i<SCANBUF_SIZE; i++)


{



if (*(in_buffer+i) > 0)



{




count++;



}


}

/* defined PIX_THRESHOLD in header file */

if (count >= PIX_THRESHOLD)


{



return 0;


}


else


{



return 1;


}
}

/******************************************************/
/*                                                    */

/* Function  : send_SI()                              */

/* Use       : to generate an SI pulse periodically   */                       

/* Arguments : none                                   */

/* Returns   : none                                   */

/* 









    */
/******************************************************/
void send_SI()

{

/* set up registers */

TIM0 = (volatile ioport unsigned int*)0x1000;


PRD0 = (volatile ioport unsigned int*)0x1001;


TCR0 = (volatile ioport unsigned int*)0x1002;


PRSC0 = (volatile ioport unsigned int*)0x1003;


/* timer period of 65536 clock cycles */

*PRD0 = 0xFFFF;



/ * set prescaler to 1 */

*PRSC0 = 0;




/* load into TCR0 */

*TCR0 = 0xCF0;



/* start timer */

*TCR0 &= 0xFBEF;

}

/******************************************************/
/*                                                    */

/* Function  : setup_timer()                          */

/* Use       : to generate 2MHz CCD clock             */                       

/* Arguments : none                                   */

/* Returns   : none                                   */

/* 









    */
/******************************************************/
void setup_timer()

{


/* timer for 2MHz CCD clock input */

TIM1 = (volatile ioport unsigned int*)0x2400;


PRD1 = (volatile ioport unsigned int*)0x2401;


TCR1 = (volatile ioport unsigned int*)0x2402;


PRSC1 = (volatile ioport unsigned int*)0x2403;


/* set timer period of 10 */

*PRD1 = 9; 




/* set timer prescaler of 5 */

*PRSC1 = 4; 



/* load into TCR1 and start timer */

*TCR1 = 0x0D38; 


*TCR1 &= 0xFBEF; 

}

/******************************************************/
/*                                                    */

/* Function  : main( )                                */

/* Use       : main program function                  */                       

/* Arguments : none                                   */

/* Returns   : none                                   */

/* 









    */
/******************************************************/
void main(void)

{


/* Local variables */

Uint16 scan_count;


Uint16 tempTx, j;


/* for GPIO */

IODIR = (volatile ioport unsigned int*)0x3400;


IODATA = (volatile ioport unsigned int*)0x3401;


/* data receive register - data from CCD scanner */

DDR10 = (volatile ioport unsigned int*)0x2801;

     /* Initialize the board support library, */


/* must be first BSL call */

DSK5510_init();


/* Initialize chip support library */ 


CSL_init();


/* Initialize the LED and DIP switch modules */


/* of Board Support Library */ 

    DSK5510_LED_init();

    DSK5510_DIP_init();


/* route CPU clock to TOUT pin. */

/* Required for C5510 board */

tempTx = DSK5510_rget(DSK5510_MISC);


tempTx = tempTx | 0x0C;


DSK5510_rset(DSK5510_MISC, tempTx);


/* Generate 2MHz clock for CCD */

setup_timer();


/* start scanning without reading data */


/* to flush scanner */

send_SI();




/* open McBSP Port 0 */


/* will return MCBSP handle to other CSL funcs */ 


mhMcbsp = MCBSP_open(MCBSP_PORT0, MCBSP_OPEN_RESET);


/* Write configuration structure values */


/* to MCBSP control registers */                                             


MCBSP_config(mhMcbsp, &Config16); 


/* Start Sample Rate Generator and Frame Sync */

MCBSP_start(mhMcbsp, MCBSP_SRGR_START | 




MCBSP_SRGR_FRAMESYNC, 0x300);


/* Enable MCBSP receive */ 


MCBSP_start(mhMcbsp, MCBSP_RCV_START, 0x200);


/* Main loop */

while(DSK5510_DIP_get(2) == 1)


{




scan_count = 0;

          /* Read in all the scans that we need */


while(scan_count < NUM_SCANS)



{




/* Read a single scan */



if(read_single_scan(buf_ptr) == 0)




{






/* success, increment scan count */




scan_count++;





}





else



{





/* scanning error */





DSK5510_LED_on(1);







}


      
}

}


/* user pressed "finish" button, so end program.*/

/* We are done with MCBSP, so close it */ 


MCBSP_close(mhMcbsp);

}
Appendix E – Image of Project Setup 
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